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What is TaxFind?
TaxFind™ is the Canadian Tax Foundation's electronic search service, which uses FolioViews®, a third-party search and retrieval software which functions like a database (called ‘infobases’). 
TaxFind™ is available on the ‘guest’ computer in the law library reference office.  Double click on the ‘Law Research CDs’ tab on the desktop, and then on ‘TaxFind’.  

TaxFind™ contains two separate infobases: a publications infobase (TAXFIND.NFO) and an index infobase (INDEX.NFO). The publications infobase contains the full text of the Annual Conference Reports, Corporate Management Reports, Canadian Tax Journal/Revue fiscale canadienne, and regional conferences starting with 1991 publications.  Selected pre-1991 articles are being added to the infobase. The index infobase contains cumulative and supplementary indexes starting with 1986.

The contents of the infobases are also listed in the user information section of the infobase.  Double click on the User Information button at the top of either infobase.  Help is also available anywhere in TaxFind™ by pressing F1.  
Starting Out
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The Opening Screen

Main Toolbar
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Canadian TaxJournal
Issue No. 1
The Canadian Home Buyers' Plan: Tax Beneft, Tax Expenditure, and Policy Assessment
Marion Steele
Précis

2007CTI1 5.2 The Canadisn Home Buyess’ Plan (Stecl, 1) :1
Abstract

‘This article estimates the tax benefits of the Canadian home bugers' plan (HBP). The benefi is greater the higher the effective marginal tax rate of the
contributor to the registered retirement savings plan (RRSP) used to create the HBP. It is very large for couples with highly disparate tax rates, which is
particularly licely for those with child-care expenses. Analysis of tax data suggests that the typical creator of an HBP is a short-term saverions who confributes
to an RRSP shortly before the HBP withdrawal—and that most RRSP contributions of taxpayers under the age of 45 are mofivated by the desire to create an
HBP. The benefit calculations use effective marginal tax rates estimated for various typical households, by education level, The rates are very high for typical
lone parents because of the impact of programs such as the child tax benefit. While this means that in principle the tax benefit could be progressive, the
evidence shows that in practice the HBP program is highly regressive. In cases where the taxpayer has no available RRSP room, the taz benefiris found to be
trivial. The HBP tax expenditure in 2005 is estimated under alternative assumptions and ranges from just under $150 millon to slightly under $300 million
2007CTI1 5.2 The Canatisn Home Buyers'Plan Gteee, 1)
One rationale for the HBP is that it encourages home ownership. However, the incentive is weak for most of those in the low-income group, where the home
ownership rate is the lowest. A second rationale is that the HBP encourages saving. Wil the evidence presented in the artcle suggests that the direct effect of
the HBP on saving is limited, to the extent that the HBP increases home ownership, it increases wealth: data for high-income households indicate that
homeowners have far greater assets, aside from their home, than ofherwise simiar renters. The HBP encourages delay in home ownership to accumiate a
large down payment (a third rationale for the program). However, the article shows thaf, under reasonable assumptions, delaying home ownership in order to _'_|
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The main toolbar is divided into three sections: 1) Standard 2) Navigation (see "Links") and 3) Personalize.  (See "Other Useful Tools.")
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Each of these three sections can be included on the Main Toolbar by going to View – Toolbars and then selecting or deselecting Personalize, Navigation, or Standard.  The toolbar can also be personalized by choosing ‘customize’ from the Tools menu, and then dragging the icon you want to the toolbar.
Infobase Views Tabs

The opening default screen displays the All view with four panes: 

1) Document pane; 

2) Reference Window pane (displays where you are in the infobase); 

3) Contents pane (displays branched table on contents, location of hits when searching); and 

4) Hit List pane (displays search results). 

You can change the size of the panes by moving your cursor to the dividing line between the panes (the cursor becomes a line with a double-headed arrow) and dragging to the desired size. The All view allows you to see all of the related information at once, but it is not the only way to view the information. 

The view can be changed by clicking on any of the tabs located just under the Hit List pane:
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Status Bar

Located at the bottom of screen, status bar gives location information for the infobases, such as the number of the current record, total number of records, the current number out of the total number of hits, and the text of your last search or query.
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The Opening Screen

Try searching with each of the three methods to find out which method consistently gives you the results you are looking
for. We recommend you use the "Advanced Query” or any of the Query templates.

Status Bar

Located at the bottor of screen, status bar gives location information for the infobases, such as the number of the
current record, total nurmber of records, the curtent number out of the total number of hits, and the text of your last
search or query.
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Searching – An Overview
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Canadian TaxJournal
Issue No. 1
The Canadian Home Buyers' Plan: Tax Beneft, Tax Expenditure, and Policy Assessment
Marion Steele
Précis

2007CTI1 5.2 The Canadisn Home Buyess’ Plan (Stecl, 1) :1
Abstract

‘This article estimates the tax benefits of the Canadian home bugers' plan (HBP). The benefi is greater the higher the effective marginal tax rate of the
contributor to the registered retirement savings plan (RRSP) used to create the HBP. It is very large for couples with highly disparate tax rates, which is
particularly licely for those with child-care expenses. Analysis of tax data suggests that the typical creator of an HBP is a short-term saverions who confributes
to an RRSP shortly before the HBP withdrawal—and that most RRSP contributions of taxpayers under the age of 45 are mofivated by the desire to create an
HBP. The benefit calculations use effective marginal tax rates estimated for various typical households, by education level, The rates are very high for typical
lone parents because of the impact of programs such as the child tax benefit. While this means that in principle the tax benefit could be progressive, the
evidence shows that in practice the HBP program is highly regressive. In cases where the taxpayer has no available RRSP room, the taz benefiris found to be
trivial. The HBP tax expenditure in 2005 is estimated under alternative assumptions and ranges from just under $150 millon to slightly under $300 million
2007CTI1 5.2 The Canatisn Home Buyers'Plan Gteee, 1)
One rationale for the HBP is that it encourages home ownership. However, the incentive is weak for most of those in the low-income group, where the home
ownership rate is the lowest. A second rationale is that the HBP encourages saving. Wil the evidence presented in the artcle suggests that the direct effect of
the HBP on saving is limited, to the extent that the HBP increases home ownership, it increases wealth: data for high-income households indicate that
homeowners have far greater assets, aside from their home, than ofherwise simiar renters. The HBP encourages delay in home ownership to accumiate a
large down payment (a third rationale for the program). However, the article shows thaf, under reasonable assumptions, delaying home ownership in order to _'_|
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You can search for a word or phrase in TaxFind.  All searches or queries are performed using the Advanced Query or specialized Query Templates, available from the ‘Search’ menu.  Advanced search is also available by clicking on the binoculars in the bottom left corner of the screen, in the ‘Search bar’.
When searching:

1)  Enter your search criteria or, when applicable, double click a word on the word list.  

2)  Use quotation marks before and after a word string or phrase to limit the search to a specific set of words, (e.g., a search for "abusive transaction" brings up all hits with that particular phrase, while a search for abusive transaction brings up all records containing both words—abusive and transaction—in any order).

A more complete discussion of operators appears in the “Searching with Operators” section.
Query Templates

To quickly narrow your search by year, publication, or author, select a Query template from the Search menu.

TaxFind.nfo templates—1) Publications-Search 2) Publications-Recherche - allows you to limit your search to certain Years, particular Authors, and specific Publications.
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Index.nfo templates— 1) Index-Search 2) Index-Recherche - allows you to limit your search by Year and Title, Author, Case, or Subject. 

By clicking in each box of the query template, the choices for that box will appear in the word list.  Double-click on your criteria.

•With "year": all years will be searched by leaving the box blank; a particular year by double-clicking on it in the word list; or a range of years using the greater than (>) and less than (<) keys.

•Leaving a box blank means the search will cover the entire infobase within that scope (i.e., all years, all authors, or all publications).

French Templates — To narrow your search to the French text in TaxFind™, select Search and Publications – Recherche or Index – Recherche depending on which infobase you are in.  The search parameters for the French template are the same as the English template.  TaxFind™ recognizes the same codes for accents as most standard Windows wordprocessing programs.  Often, however, typing a word without accents brings the accented word up in the word wheel. Some common accent replacements are:
	ALT + 0232
è
	ALT + 0224
à
	ALT + 0238
î

	ALT + 0233
é
	ALT + 0226
â


	ALT + 0231
ç

	ALT + 0201
É
	ALT + 0192
À
	ALT + 0244
ô




Search Results 

The Records With Hits box in the Query Dialog shows how the search is progressing.  It shows what is being searched for and the number of “hits” (or matches) the search has generated.

Once your query is complete, click OK and you will be taken to the first hit in the infobase.  Advance to the next hit by clicking on the forward arrow button beside the binoculars on the Search bar (the back arrow button will bring you to the previous hit of your query). You can also go directly to any of the hits in the HitList (the bottom pane of the viewing screen, also available from the bottom ‘Hit List’ tab).

NB:  If the search term you used appears in a reference line, you will have a hit for every record in the paper with a reference line.

Searching for Section References or Specific Phrases

When searching for a subsection, paragraph, or subparagraph, enter your reference or query in quotation marks (e.g., "69(1)" or "stop-loss rules") to ensure that you only retrieve references to that particular section or query.

The “Art” of Searching

This section introduces you to some sample search strategies, such as using the OR operator to expand your search by retrieving words with common meaning; or using the AND operator to contract your search by retrieving records with all search terms contained in a specific record.

Example 1: Suppose you want to retrieve any records that deal with the application of the general anti-avoidance rule in conjunction with the forgiveness of debt.  The OR operator enables you to find all occurrences of any of the words associated with a given topic. Thus, the following query would achieve the desired results:

(gaar OR 245 OR avoidance)&(80 OR forgiveness)

NOTE:  The AND operator separates the two sets of words. It will retrieve all records that contain at least one word from both of the sets.

Note that the OR operator is evaluated first. This means that all the variations of the words connected by the OR operators are retrieved.  The two resulting sets of records are then evaluated using the AND operator, resulting in a collection of records that contain at least one word from each of the sets resulting from the OR evaluation.

Example 2: Another example of a combined complex search, this time using specific phrases, might be:

butterfly OR "55(3)(b)"&"proceeds of disposition" OR "safe income"

Searching with Operators
Search operators between search terms refine your search criteria by logically broadening or restricting the terms.  TaxFind™ uses the following Boolean operators or search aids:


And
 
A B or A&B or A and B


Or
 
A|B or A or B


Not

A^B or A not B or not B


Phrase

"AB"


Proximity
"AB"/5 or "AB"@5


Nesting

(A&B or (C&D))^E

Using AND

If you need to narrow your search to find, for example, information about "reorganization" and "butterfly," either of the following queries will find all records containing both words:

reorganization&butterfly

The "space" or "&" between reorganization and butterfly indicates that you wish to limit your search to records that contain both the word reorganization and the word butterfly.  The default operator is AND.  Therefore, if you do not use an operator, TaxFind™ uses AND.

NOTE: Do not type the word "and" unless you want to search for that word. TaxFind™ indexes every word and therefore searches literally for every character in the query except for spaces (And operator), | (Or operator), ^ (Not operator), and @ (Proximity operator), " (Phrase operator), and other more specialized operators.

Using OR

Your search may be expanded to select records or levels with one or more words.  For example, the query

reorganization|reorganizations|amalgamation

would find any records containing one or more of the three words.

The | (pipe) is equivalent to OR.  As an alternative, you could also use wildcard characters and enter the following query in order to include all extensions:

reorganization*|amalgamation*

Using NOT

Suppose you are interested in information about reorganizations, but only if the information is not connected with reorganizations of capital in any way.  You might build the following query to search for all records containing the word "reorganization" but NOT those which also mention "capital."  Enter the query

reorganization*^capital*

The carat character (^) is equivalent to NOT.

Using EXCLUSIVE OR

Perhaps some records may mention "reorganization" and "amalgamation" but you only want those records that mention either one OR the other but NOT both.  You would build a query using the EXCLUSIVE OR operator as follows:

reorganization*~amalgamation*

Using SPECIFIC PHRASES

Using specific phrases is generally a fast, efficient way of retrieving exactly what you want.  It should be used for searches with the specialized templates.

Type the exact phrase, or consecutive words, into the query within quote marks.  TaxFind™ will find only records where the exact phrase within the quote marks appears.


Examples:
"real estate"




"paid-up capital"




"available for use"

TaxFind™ includes hyphens and apostrophes in search results if not specified as a phrase.  Therefore, a search for paid up will find instances of paid up and paid-up.

Using PROXIMITY SEARCHING

Since records represent full paragraphs, you may narrow your search to words within a certain proximity of each other.  Ordered proximity searches where the search terms must be in a given order are denoted by the / (slash) and a number.


Example:
"refund amount"/25

is an ordered proximity search that will find all records where the word refund precedes the word amount within 25 words.

In an unordered proximity search, it does not matter in which order the terms appear in the text.  Structure your search string with an @ and a number following the phrase.


Example:
"dividends redemption shares"@10

In this example, the hit list will contain only the records where the words "dividends", "redemption", and "shares" are within 10 words of each other in any order.

Through the use of ordered or unordered proximity searching, you can control the relationship of the terms in your search.

NB: Wildcards cannot be used in phrase or proximity searches. The * or ? will be searched for as literal matches.

Word Variations - Wildcard Characters

If you wish to search for variations of a word—for example, reorganization and reorganizations—you could enter the query as reorganization*.  The star (*) substitutes any number of characters following the "n" in reorganization.

For example, if you typed farm* as your query, your search may include farm, farms, farmer, farming, and farmland.

A question mark (?) is another character substitute.  However, it substitutes a single wildcard character, whereas the * substitutes multiple wildcard characters.  If your query was farm?, the result would be equivalent to typing farms, and would exclude the words farm, farming, or other variations.

NOTE:  The words found in searches using wildcards are not highlighted in the resulting narrowed view.

NB: Wildcards cannot be used in phrase or proximity searches. The * or ? will be searched for as literal matches.

Stem Queries

Stem queries find all variants of a word based on the stem (or root) of the word.  The stem operator is the % sign (%).

The Search Syntax Table of this guide summarizes query terms.

Combining Search Features

As indicated above, the query

reorganization*^capital

can be used to exclude reorganizations of capital from the search results.  However, any records that discuss paid-up capital, capital property, or capital tax would also be excluded.  By combining features, an alternative query would be

reorganization*^"reorganization capital"@3

This would exclude records with the phrases "capital reorganization" and "reorganization of capital", but is less likely to exclude records discussing paid-up capital, capital property, and capital tax implications of a reorganization.

Nesting

In performing a search using more than one logical operator, TaxFind™ forces a standard evaluation order of the logic operators.  The standard evaluation order is:


1)
Parenthesis ( )


2)
Not^


3)
Or/


4)
Exclusive Or ~


5)
And &

For example, in the query ("Fair Market Value")&("income attribution"), TaxFind™ will look first for records containing the phrase "Fair Market Value," then for all records containing the phrase "income attribution," and then for records that contain both those phrases. The search template creates the same pattern using levels rather than records.

Hits or Search Results

Hits are words or structures that match your search term.  When possible, hits are highlighted.  The simplest way to view hits is outlined below:

1.  Perform query search.

2.  Select OK to go to first hit.

3.  Use the ‘forward’ or ‘back’ arrows to see other hits.

Tools for Managing Hits

After a few searches, it becomes clear that results management is critical to the successful use of TaxFind™.  When faced with a long list of hits, the forward and back arrows may not be the most efficient way to view the hits.

You have two options: 1) redefine or narrow the search in a more specific manner; and/or 2) manage the results list more effectively.  Query results can be viewed in the text, in the Contents pane, and in the HitList pane.

Hits in the Body of the Text

a) Records with Hits: Select Records with Hits from the View menu after the search is completed.  The ONLY records that will be on your screen are those that match your search criteria.

b) The reference line above each record will tell you the location of each hit.

When you find material that you want to read in full, click on the record to position the cursor in the record, then go to the View menu and select All Records by clicking on it.  This takes you back to the full text of the infobase.  
Hits in the Contents Pane

The tools used here are Query Results, Headings with Hits and Words around Hits.  Going to the Contents pane after a search can give you a useful overview of the location and the context of hits to help determine which hits are most useful.

a) To check if the above features are enabled, go to Tools Þ Options Þ Contents. Query Results, Headings with Hits and Words around Hits should be selected.
b) Click on the Contents tab—Show Query Results displays each heading with the number of hits within the heading.  

Keep in mind when viewing hits in the Contents pane that : 

i) the level headings used in theTaxFind.nfo infobase are year, publication, issue no. (for Journals), title, author, main heading, etc. (in the Index.nfo infobase: year, index, alpha, list); and

ii) each "+" or "–" represents a branch.

In the Contents pane, you will find several options for viewing your search results in the View menu. Using the sample search below, the following options can be found on the View menu. 

1)  Expand one level:  If you highlight one year (e.g., 2003), and select Expand one level, that branch will expand to display all the publication headings (the next level) that have hits.

2)  Expand branch: If you highlight a year and select Expand branch, that branch will expand to display all levels beneath it.

3)  Expand to level: To quickly display, for example, all titles with hits, select Expand to level. A Levels box will appear. Scroll down to Title and select it. Click OK and the search results will display all the papers with hits by title.
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Example: search result for "estate planning" in the Contents pane. The pane on the left displays hits by the "year" level. The one on the right shows how to expand down into the levels by clicking on the "+".

Double-click on any heading to go to the beginning of the full text of the article.  Click on the forward arrow and the cursor jumps to the highlighted term.

After a search, the Contents pane can be restricted to only the headings that contain hits by clicking on the Contents tab.  

Hits in the HitList Pane

The Hit List provides a means of viewing headings that contain hits. After a search, the HitList pane displays search results in order of importance.

Click on the HitList tab—Words around Hits displays 5 words on either side of the hit to help establish the context.  The default for TaxFind™ is 5, but can be changed through by going to the Tools menu Þ Options Þ Hit List  Þ select Words around Hits and enter the number of words around hits you wish to display

Viewing your results in both the HitList and Contents panes is a good way to determine the value of your search results. The HitList pane shows you the results by heading while the Contents pane is most useful for year and publication. 

Show History
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Show History (from the ‘Search’ menu or the main toolbar) keeps a history of all searches performed in an infobase during a search session.  It is very useful if you need to reconstruct a search or wish to return to a previous search result.  Click on the icon, select whichever search interests you, and click the Go To button.

NB:  Hits in Reference Lines — If your search term turns up a large number of hits, it may be that your search term is part of the title or reference line.  This would mean that every paragraph (or record) in the article would turn up as a hit.  A look at the contents would allow you to jump over articles of no interest.

Reference Lines
TaxFind™ has a reference line for each folio record so that you can always identify where you are in the infobase and what the complete source for each "hit" is. The reference line consists of year, publication, paper number, title, and author. This is particularly useful when viewing "records with hits." The reference line contains the same information found in the reference pane, with the added feature of the page number used in citing Foundation material. The reference line is unique to TaxFind™ and is invaluable when viewing search results that can cover many different publications and years. NOTE: DRAFT papers do not contain page numbers. If the reference lines are turned off by accident, they can be reactivated by selecting Hidden from View in the Main menu.
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Footnotes
Linking through footnotes allows you to navigate from one location in an infobase to another location in the same infobase.   The footnotes are located at the bottom of each paper. Links go in both directions—from the text to the footnote, and from the footnote to the text. In the example below, the footnote link is in red 50. Double-clicking on any of these links in TaxFind will take you to the corresponding footnote.  To go back to the text, double-click on the footnote number, or click on the back arrow from the Main Toolbar.  
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The references in blue, as well as the pink and green diamonds, are links to other databases to which we do not subscribe.
Other Useful Tools
This section is a brief introduction to some additional tools that can make information management an easier task.  More complete details on bookmarks, notes, and highlighters are in the electronic version of the TaxFind help manual (press F1 to access).

Bookmarks

Bookmarks hold your place in an infobase whether the infobase is open or closed.

• To place a bookmark, place cursor at insertion point, click on the Bookmark icon, and type a unique name for the bookmark.  Choose OK.

• To go to a bookmark, click on the Bookmark icon and select the bookmark you wish to turn to.  Choose Go To.

• To remove a bookmark, click on the Bookmark icon, and select the bookmark you wish to remove.  Choose Delete, Yes.

Notes

Notes (appear as yellow “sticky notes”) allows the user to comment on the text.  This feature can be particularly useful in a network environment when more than one person is working on a particular problem.  Notes can also be searched.

• To create a note, click on the Note icon.  When the Note Window opens, type or paste in your text.  Click on the "X" in the upper right hand corner to close the note and select Yes to save the note.

• To remove a note, move the cursor to the paragraph containing the note and choose Remove Note from the Tools menu (or press CTRL + Shift +N).

• To search a note, click the Query button.  Type [ (square bracket), double-click Note from the scope box (adds "Note" to the query), and type the terms (if you do not specify any terms, all instances of notes will be found). Close the square bracket (]). Choose OK.

Highlighters

This feature allows the user to highlight material in the infobase which can then be searched.  This allows the user to build a file on a particular subject or case.

• To create a highlighter, select the text; click on the Highlighter icon; click on "new" if this is a new highlighter; name the Highlighter; and select a colour for the highlighter.   Choose OK, Apply.

• To apply a highlighter, select the text you want to apply the highlighter to, click on the Highlighter icon, and select the highlighter to apply.  Choose Apply.

• To clear a single highlighter from the text, select the text you wish to clear the highlighter from, and choose Remove Highlighter from the Tools menu.

• To remove all highlighters on a particular subject, click on the Highlighter icon, select the highlighter you want to remove, and choose Delete, Yes, Close.

• To search a highlighter, choose Query from the Search menu, type  [ (square bracket), or click on the [ in the lower left hand corner of the search box, double-click Highlighter from the scope box, type the name of the highlighter you wish to search for followed by a colon, type the terms you wish to search for (if you do not specify the terms, all instances of the highlighter will be found), and type ] to close the highlighter.  Choose OK.

Exporting to a Word Processor

Generic files created from TaxFind™ can be retrieved into most word processing packages such as WordPerfect or Word.  However, generic word processing files, although word-wrapped (unlike DOS or ASCII files which have a hard return after each line), do not contain formatting attributes such as bold and indent.

To save part of the TaxFind™ infobase to a word processing format, use the following procedure:

• Select or Tag (CTRL+T) the text you wish to export.

• Choose Save As from the File menu.

• Open the List Files of Type menu and select the intended file format the text is to be saved as.

• Select File Name and type a name the file will be saved as.

• Change drives and directories, as needed, to specify where the file should be saved.

• Choose OK.

NOTE: The copyright banner will appear at the bottom of every separate block of information saved to another format or printed.

Switching Infobases

Once both the publications and index infobases are open, jumping from one to the other is fast and simple.  There are different methods for switching from one infobase to the other.

• Go to the top of the infobase (CTRL + HOME) and double click on the Publications or Index button.

• Window menu: toggle between open infobases using the Window drop-down menu at the top of the screen.
• The open windows are listed at the bottom with the active infobase selected.  Highlight the infobase you would like to switch to and the screen will automatically change to your selection.

Printing
Print Options

Before printing anything, decide on which attributes you want to print. To select your print options, go to Tools – Options – Print and select the options you want to print.

1) To print the reference line, select "Hidden text."

2) To print the information in the reference window, select "Inline headings." Please note that, as with the reference line, the inline heading will print above every record.

Note: For reference purposes, you can choose to print either the reference line or the inline headings, but not both since they display similar information. The reference line will have the page number used for citing CTF material.

Printing an Entire Paper

If you are in a document and want to print it: 1) if not already, change to the All view; 2) using the reference line, find the location of the paper in the Contents pane; 3) check the corresponding box; 4) proceed to Print; 5) select the All radial button; 6) click OK.

The print dialog box can be accessed by 1) clicking on the Printer icon on the Main Toolbar, or 2) going to File – Print.

On the bottom left corner of the print dialog the following box displays the checked box of the paper you wish to print.

Note: If a box has not been checked and the All radial button selected, the ENTIRE infobase will be printed.

Printing a Section of a Paper

If you are in a document and want to a section of it: 1) if not already, change to the All view; 2) using the reference line, find the location of the paper in the Contents pane; 3) expand to the exact branch(es) that you wish to print; 4) check the corresponding boxes; 5) proceed to Print; 6) select the Section radial button; 7) click OK.

Printing a Small Selected Area of Text

To print a selected area of text follow the steps outlined below:

1)
Highlight or tag (CTRL+T) the text you wish to print.  


To print the reference line go to Tools – Options – Print and select Hidden text.

NOTE: To print footnotes associated with a particular paragraph, tag the paragraph (CTRL+T), double click on the footnote link to go to that footnote, tag the footnote, and then click on the back arrow.  After you have printed, remember to clear the tags by selecting Clear All Tags from your Edit Menu.

2)
Click the Printer icon on the Main Toolbar; or 2) go to File – Print.

3)
Select Selection or Tagged records under the document tab

4)
Click OK or press ENTER.

5)
Clear tags Edit – Clear all tags (if used).

Printing Search Results in the Table of Contents

1)
In the All view, perform Search.

2)
With the cursor in the Contents pane, on the Main menu go to View – select Records with Hits.

3)
Select File and Print from the Main menu.

4)
Select Print Contents from the print dialog.

5)
Select the appropriate option.

6)
Press OK.

Printing the Hit List

1)
In the All view, perform Search.

2)
Select File and Print from the Main menu.

3)
Select Print HitList from the print dialog. 

4)
Select the appropriate option.

5)
Press OK.
Search Operators 
	Operator or Scope
	Example
	
	

	And
	one two
	one & two
	one and two

	Or
	me | you        
	me or you
	

	Not
	^ him             
	not him             
	her ^ him

	Exclusive Or (Xor)
	apples ~ oranges           
	apples xor oranges
	

	Phrase
	"to be or not"                 
	"fourscore and seven"
	

	Single Character Wildcard
	wom?n                          
	g??b?r

	

	Muliple Character Wildcard
	work*                             
	h*t*
	

	Ordered Proximity
	"united states of america"/10

	
	

	Unordered Proximity
	"uncle sams army"@7

	
	

	Record Proximity
	"smith jones theft deny"#5
	
	

	Sentence Proximity
	"nextpage products" /s

	
	

	Paragraph Proximity
	"folio help infobase" /p

	
	

	Stem (Word Form)
	run%                             
	great%

	

	Thesaurus (Synonym)
	flying$                           
	alterations$
	

	Contents
	[Contents <heading path>] <query>
	
	

	Partition
	[Partition Chapter] advanced query
	
	

	Rank
	[Rank 10] dogs chase cats
	
	

	Range
	[Field weapons: > bullet < knife]

	
	

	Highlighters
	[Highlighter humor:marx | stooge]
	
	

	Popups and Notes
	[Note <terms>] or [Popup <terms>]
	
	

	Groups

	[Group <group name>] <query>

	
	

	Levels
	[Level <level name>:<query>]

	
	


Shortcut Keys
	Advanced Query
	F2
	Next Partition Hit
	F5

	And Operator (Advanced query)
	CTRL+A
	Next Record
	CTRL+ ¯

	Bold
	CTRL+B
	Next View
	F7

	Bookmark
	CTRL+M
	Not Operator (Advanced Query)
	CTRL+N

	Collapse Branch
	–
	Note
	CTRL+N

	Contents Pane
	CTRL+SHIFT+C
	Object Pane
	CTRL+SHIFT+O

	Copy
	CTRL+C
	Open
	CTRL+O

	Cut
	CTRL+X
	Or Operator (Advanced Query) 
	CTRL+O

	Document Pane
	CTRL+SHIFT+D
	Query
	F3

	Exclusive Or Operator 
(Advanced Query)
	CTRL+E
	Query Template
	CTRL+

	Number Key (1-9)
	
	
	

	Expand All
	CTRL+*
	Page Break
	CTRL+Q

	Expand Branch
	*
	Paste
	CTRL+V

	Expand One Level
	+
	Picture Dialog
	CTRL+SHIFT+P

	Explore Infobases
	CTRL+E
	Popup Menu
	F10

	Find Infobases
	CTRL+F
	Previous Hit
	SHIFT+F4

	Font (toolbar control)
	CTRL+SHIFT+F
	Previous Link
	CTRL+­

	Go Back
	F6
	Previous Pane
	SHIFT+F8

	Go Forward
	SHIFT+F6
	Previous Partition Hit
	SHIFT+F5

	Go To
	CTRL+G
	Previous Record
	CTRL+­

	Help
	F1
	Previous View
	SHIFT+F7

	Highlighter
	CTRL+H
	Print
	CTRL+P

	Hit List Pane
	CTRL+SHIFT+H
	Remove Link
	CTRL+SHIFT+J

	Infobase Properties
	CTRL+SHIFT+I
	Remove Note
	CTRL+SHIFT+N

	Italic
	CTRL+I
	Save
	CTRL+S

	Jump Destination
	CTRL+D
	Strikeout
	CTRL+K

	Jump Link
	CTRL+J
	Styles
	CTRL+SHIFT+S

	Next Hit
	F4
	Tag Record
	CTRL+T

	Next Link
	CTRL+ ¯
	Underline
	CTRL+U

	Next Pane
	F8
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